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About The Manual

Document revisions

This manual is revised periodically to maintain consistency with the current system hardware and software releases, to describe or update operational enhancements, and to incorporate customer suggestions.

Technical support

For technical problems and questions, contact WirelessPro Technical Support:

Telephone: 
678.942.5612

Email: 

wirelesspro.support@galaxyeng.com

Web Site: 
www.wirelessprosupport.com

1. Introduction to WirelessPro

1.1. Intended Use

WirelessPro is a software based system performance tool that interfaces to consumer grade handsets and calibrated scanners for the purpose of collecting and evaluating system performance metrics.  The uniqueness of WirelessPro resides in its software-based nature as opposed to traditional hardware based solutions that require the purchase of a hardware chassis via an equipment manufacturer. This flexibility allows WirelessPro to be used as a single technology performance tool or a multiple technology-benchmarking tool.  WirelessPro can be configured with the ability to analyze multiple technology platforms simultaneously without expensive upgrades in hardware.  Currently WirelessPro supports GSM, CDMA, IDEN and IS-136 technologies.  

1.2. System Components and Capabilities

Some products may or may not be included in your configuration based on the package plan you purchased.  For detail specification of components, please refer to Component Specification section in the Appendix.

1.2.1. Components

1.
WirelessPro Installation CD.

2.
WirelessPro License Key

3.
Off the shelf wireless handset and data cable.  Current supported devices are:

	TECHNOLOGY
	DEVICE MODEL
	DATA CABLE

	IDEN
	Motorola 370i

Motorola 500+

Motorola 550+

Motorola 700+

Motorola 1000+

Motorola 2000+
	Off the Shelf

	IS-136
	Nokia 51xx

Nokia 61xx
	DAU-9P

	GSM
	Nokia 51xx

Nokia 61xx
	DAU-9P

	CDMA
	QCP 8xx

QCP 19xx

QCP 27xx

Kyocera 2035

Kyocera 3035
	Off the Shelf 

	AMPS
	Nokia 51xx 

Nokia 61xx
	DAU-9P


Table 1.  Supported Handsets
4.
GPS with a serial data output in one of the following supported formats:

a. NMEA 0183

b. TSIP

c. Earthmate

5.
DTI Scanners

a. 800 MHz IS136

b. 800 MHz CDMA

c. 800 MHz iDEN

d. 900 MHz GSM

e. 1800 MHz GSM

f. 1900 MHz IS136

g. 1900 MHz CDMA

h. 1900 MHz GSM

1.2.2. Capabilities and Features

1.2.2.1. Maximum Number of Devices

WirelessPro operates up to 8 handsets with any combination of available technologies plus concurrent data collection on up to 6 scanners.

1.2.2.2. Collected Data and Interpretation

WirelessPro is able to measure, collect and display parameters from the handsets and scanners.  A general list is given below.  For more specific information see Appendix A.

1.
Collect RF Signal information from the various technologies

2.
Collect and decode Layer 3 information

3.
Determine call events such as:

· Call Setup

· Call Termination

· Call Setup Failure

· Call Drop

· Handover

· Reselection

1.2.2.3. Software Features

There are many specialized features in WirelessPro that aid the engineer in data collection and system optimization.  They are as follows: 

1.
Real time map display using MapInfo workspace

2.
Autocall module for control call placement on the handsets

3.
Cell Site Database integrated on the map and data viewers

4.
User defined alarms 

1.3. Graphical User Interface (GUI)

The WirelessPro GUI is composed of a Main Control bar and other windows that may be launched from the Main Control bar.  

1.4. Computer Requirements

1.4.1. Minimum PC Requirements

500 MHz Pentium III Processor

128 Meg RAM

1 Gigabyte Available Hard Disk Space (for data logging)

Windows NT 4.0 or Windows 2000

MapInfo® Professional 4.5 or later (for mapping)

Microsoft Excel 2000 (for Post Processing Reports)

1.4.2. Recommended PC Specifications

750 MHz Pentium III Processor

256 Meg RAM

6 Gigabytes Available Hard Disk Space (for data logging)

Windows 2000

MapInfo® Professional 6.5 or later (for mapping)

Microsoft Excel 2000 (for Post Processing Reports)

1.4.3. Operating System

Windows 2000 is the recommended OS.  Windows NT 4.0 is also supported; however, the plug and play aspect of this OS creates some difficulties for users at times. WirelessPro does not support Windows 98.

1.4.4. Third Party Products

1.4.4.1. MapInfo Professional Software

MapInfo Profession version 4.5 or higher is required for using the map display in WirelessPro.

1.4.4.2. Microsoft Excel Software

Microsoft Excel 2000 is required for generating reports in WirelessPro’s Post Processing Module.

1.5. Optional Equipment

1.5.1. VQUAL

VQUALTM may be used for QoS measurements.  VQUAL can be monitored and controlled from within WirelessPro to give the user a complete assessment of the user perceived system quality.

1.6. Installing WirelessPro

To install the WirelessPro software, do the following:

· Insert the WirelessPro CD into your CD_ROM drive.  
· If the auto-run feature isn’t enabled on your computer, double-click the Setup.exe program in the CD’s root directory.
· To continue the installation, follow the InstallShield Wizard instructions.  When the InstallShield Wizard Completed dialog box appears, the application has been installed successfully.
· To complete the installation, click Finish or press Enter. 
1.7. Uninstalling

Uninstall WirelessPro using the Add/Remove Programs application in the Windows Control Panel, as follows:

· From the Windows Start menu, select Settings, and then choose Control Panel from the Settings submenu.

· Locate the Add/Remove Programs application in the Control Panel window and double-click on it.  The Add/Remove Programs window appears.

· In the Add/Remove Programs window select WirelessPro then click Remove.  Follow the remaining instructions in the Uninstall Wizard to complete the removal.

1.8. Help

WirelessPro’s Help menu gives you access to online hypertext information about using WirelessPro.

To Open WirelessPro Help, Select Help then contents from the WirelessPro main menu bar.

2. Setups

2.1. Overview

Before performing a data collection the user will need to configure certain hardware and software settings.  This section will detail those key concepts used to setup the WirelessPro test equipment.

2.2. Before You Start

2.2.1. What you need to know about MapInfo

WirelessPro uses MapInfo for displaying maps within the tool.  However, it is not necessary to run MapInfo Professional while operating WirelessPro.  

If you so choose you may run MapInfo while also running WirelessPro.  However, note that you may not be able to open the same MapInfo tables and workspaces in both applications due to conflicts.  

2.2.2. Hardware Key

A hardware key is required for the software for real time data collection and system optimization.  The hardware key plugs into the parallel port of the computer.  Currently the hardware key is not required for non-real time usage of the software, including data analysis and data export.

2.3. Device Connections

Each device connects to the laptop via a serial communications port.  For your convenience a USB serial port hub is included to simplify the connection of multiple devices. 

2.3.1. Connecting the USB serial port hub 

The USB serial port hub connects to the computer via a USB cable.  Plug one end of the USB cable into the USB box and the other into an available USB port on the computer.  The serial ports on the USB box can be used as available ports for connecting handsets, scanners, and GPS.

2.3.2. Connecting Handsets

Handsets are connected to the computer via a handset data cable.  Plug the RS232 end of the data cable to an available serial port.  The other terminus of the data cable plugs directly into the bottom of the handset.  For the Nokia GSM handset, a special serial adapter is required between the data cable RS232 connector and the COM port.

2.3.3. Connecting Scanners

Most scanners have two connectors, a RF input connector and a data/power connector.  CDMA scanners have an extra GPS connector.  Connect the male RS232 end of the scanner data/power cable to the appropriate connector on the scanner.  Connect the female RS232 end of the data/power cable to an available serial port.  Finally, connect the DC plug on the data/power cable to an available DC power outlet.  

Connect the TNC connector of the antenna to the appropriate port on the scanner.  For CDMA scanners connect the SMA connector of the GPS to the GPS port on the scanner.  

2.3.4. Connecting GPS

The Garmin GPS included in the hardware kit terminates in a 12v DC plug and a female RS232 connector.  Connect the DC power adapter to an available DC power outlet and connect the RS232 connector to an available serial port.

2.4. System Configuration

2.4.1. Port Config

In order to establish connections to the wireless devices, each device must be named and associated with a device type and a communication port.  

On the Main Control, use “Configure Ports” under “File” menu to accomplish this.
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Figure 1.  Port Configuration
2.4.1.1. Device Setup

Name a device and choose the type.

2.4.1.2. COM Ports

Indicate the serial communications port to which the device is connected.  You may either specify a specific serial COM port or a port on the USB serial Hub.  To specify a specific COM port, unselect the check box and choose the COM port from the drop down list.   To specify a port on the USB serial hub select the check box and choose the USB port from the drop down list.  The USB port number is the number indicated on the USB serial hub where the associated device is connected.

2.4.2. Phone Configuration

To view or edit the current phone configuration, click Phones under the Config menu.  The options available for the phones vary by technology.  The specific configurations that are available can be found in session 4. 

2.4.3. Scanner Configuration

To view or edit the scanner configuration, click Scanners under the Config menu.  
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Figure 2.  Config Scanners Menu

The Scanner Configuration dialog will appear.

2.4.3.1.   Specifying the Scan List

There are several different methods you can use to specify the channels or pilots that are to be measured.

· Double click any single channel from Available list to add it, or double click any single channel from Scan List to remove it.

· Use “Shift” and/or “Ctrl” key to select multiple channels from either Available list or Scan List, then click “< == >” button to add or remove them.

· Click Add All or Remove All.

· Click Auto Select On.  Then select from Common Group or enter the Start, Stop, and Inc values.  Click Add to insert the specified values into the scan list.
2.4.3.2. CW Scanner Options

The configuration below is for an IS-136 scanner.  Although the options vary by technology, most of the parameters are common to all scanners:
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Figure 3.  CW Scanner Configuration
· Scan List ID - For non-CDMA scanners this value should always be “1”

· Scan Type – Always “CW” for non-CDMA scanners

· Estimated Scan Time – Based on the current configuration this value is the amount of time for each scan to complete in seconds.  The smaller number is the amount of time for a non-DVCC/BSIC decoded scan.  The larger number is the max amount of time that a DVCC/BSIC decoded scan may require.

· DVCC (BSIC) Rate – Controls the frequency at which DVCC/BSIC decoding is performed.  This value indicates the number of non-DVCC/BSIC scans to perform between every DVCC/BSIC scan.  A value of “0” would indicate that every scan should include DVCC/BSIC decoding.  A value of “2” would indicate that every third scan should include DVCC/BSIC decoding.  (This parameter is hidden unless the Detect DVCC (BSIC) option is selected.)

· DVCC (BSIC) Threshold – Indicates the minimum RSSI required for DVCC/BSIC decoding to be performed on a particular channel.  (This parameter is hidden unless the Detect DVCC (BSIC) option is selected.)

·  Samples – This value indicates the number of measurements to be made on each channel before returning a result.  Smaller values will increase the frequency at which values are reported, but will decrease the averaging effect of the measurements.

· Average RSSI – Select this option if you wish the scanner to report the average measurement value for each channel
· Maximum RSSI - Select this option if you wish the scanner to report the maximum measurement value for each channel
· Minimum RSSI - Select this option if you wish the scanner to report the minimum measurement value for each channel
· STD DEV RSSI - Select this option if you wish the scanner to report the standard deviation of the measurements made on each channel
· 10th Percentile - Select this option if you wish the scanner to report the 10th percentile value for the measurements made on each channel
· 50th Percentile - Select this option if you wish the scanner to report the 50th percentile value for the measurements made on each channel
· 90th Percentile - Select this option if you wish the scanner to report the 90th percentile value for the measurements made on each channel
· Detect DVCC (BSIC) – Select this option if you wish the scanner to perform DVCC/BSIC decoding.  (This option is only available on GSM and IS-136 scanners.) 
· Wave Distance Averaging – Select this option to average the measurement results over a distance of 40 wavelengths
· Distance – Select this option to average the measurements over a specified distance
· The Available list indicates the channels that are not currently selected in the scan list
· The Scan List indicates the group of channels to be scanned.
· SAVE and LOAD buttons allow user to save and load scanner configuration
2.4.3.3. Pilot Scanner Options

CDMA based scanners have the ability to perform Pilot scans.  The configuration dialog for a pilot scan is given below:
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Figure 4.  Pilot Scan Configuration

· Scan List ID - This value should be “1”.  Future versions will allow for multiple FA scans

· Scan Type – Choose “Pilot” to perform a pilot scan

· Estimated Scan Time – Based on the current configuration this value is the amount of time for each scan to complete in seconds.

· Correlation Taps – The resolution of the pilot scan.  The more taps the lower the measured noise floor, but the slower the scan rate.  Possible values are 128, 256, 512, and 1024.

· Window Size – Indicates the window size in chips for detecting pilots, centered at the PN to be detected.  A window size of 64 would have the scanner search for pilots that are +-32 chips from the PN offset.  

· PN Threshold – Specifies the minimum Ec/Io value required for a peak to be reported. 

· Center Channel – Specifies the CDMA center channel 

· AVG Ec/Io – Select this option if you wish the scanner to report the average measurement value for each pilot
· Peak Ec/Io - Select this option if you wish the scanner to report the peak measurement value for each pilot
· AGGR Ec/Io - Select this option if you wish the scanner to report the aggregate of the measurements for each pilot
· Delay Spread- Select this option if you wish the scanner to report the delay spread between measurable peaks for each pilot
· Pilot Delay – Select this option if you wish the scanner to report the delay in chips for the strongest peak for each pilot measurement
· Wave Distance Averaging – Select this option to average the measurement results over a distance of 40 wavelengths
· Distance – Select this option to average the measurements over a specified distance
· The Available list indicates the pilots that are not currently selected in the scan list
· The Scan List indicates the group of pilots to be scanned.
2.4.3.4. Resolution vs. Samples

To illustrate the tradeoff in resolution size and the number of samples view the examples below: 

The CDMA scanner has the following specifications:

	Scan Rate < = 255 Channels
	80 Channels / Second

	Scan Rate > 255 Channels
	70 Channels / Second

	Delay per added 255 Channels
	0.5 seconds

	PN Scan
	512 PN / 1.5 seconds


The typical configuration for a PN scan is 1024 correlation taps, 192 chips window size, -10dB threshold, and PNs based on the Pilot Increment for the system.  Using these settings with a PN increment of 3 will produce measurements every 1.5 seconds.  

Using a Pilot Increment of 6 would give a scan time of 0.75 seconds

The IS-136 Scanner has the following specifications:

	Scan Rate < = 255 Channels
	407 Channels / Second

	Scan Rate > 255 Channels
	245 Channels / Second

	Color Code decode Rate
	50 Channels / Second

	Delay per added 255 Channels
	0.5 seconds


For IS136 you typically want a scan result every 0.5-2.0 seconds.  For the example you could scan 250 channels with 2 samples/channel in 1.1 seconds. 

Using DCC decoding will slow the scan rate well.  If you only do a DCC decode every 4th scan (DVCC rate of 3) and you set the threshold so that 25 channels are above threshold on average, for the same example every 4th scan will take an additional 0.5 seconds. 

2.4.4. GPS Configuration

The GPS is configured in Port Config dialog box.  You only need to specify the GPS protocol type and the COM or USB port for communication.  WirelessPro currently supports NMEA 0183, TSIP, and Earthmate protocol types.  

2.4.5. Autocall 

2.4.5.1.  Standard Setup

The Autocall is used for setting up automatic call control.
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Figure 5.  Standard Autocall Setup
First Text Box is the name given to the wireless device in the Phone Type column of Port Configurations.
Second Text Box is the state of that wireless device (i.e. "Conversation" or "Idle"). 

Min Idle is the minimum amount of time the device must be idle before attempting a new call. 

Max Setup is the maximum length of time allowed for a call to be set up - a call setup failure will occur if this timer expires.  This timer begins when the software initiates a connection attempt. 

Connect is the maximum length of time for a connection to last before call termination. 

Begin and End buttons are used to start and end phone call individually.

Start All and Stop All buttons are used to start and stop all calls at the same time.
2.4.5.2. Advanced Setup

Click Adv. Setup to edit the advanced property of Autocall.
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Figure 6.  Advanced Autocall Setup
Cycle Time is the exact length of time between call attempts - zero value means no fixed cycle time is to be used.  The default value for this variable is zero.

# Cycles is the number of connection attempts to be made - a value of zero (0) means that infinite attempts will be made.  The default value for this variable is zero.

CallSynchOn tells the Autocall to make all the wireless devices initiate connections at the same time.  This ensures that the same number of call attempts is made on all wireless devices.  The default value for this variable is off.

The following diagram visually shows how each parameter is involved in the call cycle:
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Figure 7.  Autocall timing

2.4.5.3. Saving the AutoCall profile

You can save a custom Autocall configuration by clicking the “Save Template” button.  To use an existing template or profile, choose the profile from the “Select Parameter” Combo box right under the “Dial Number” 

2.5. Options

2.5.1. Application Settings

Application Settings allows user to setup cell site databases, a map workspace, and the working directories.  To view/change Application Settings, select Application Settings under Options menu.

2.5.1.1. Cell Site Database

The Cell Site Database page allows the user to select and create the database to be used in the test.  If a Cell Site Database has already been imported it can be selected from the drop down box.  
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Figure 8.  Application Settings 1: Cell Site Database

To import a new database click the 
[image: image10.png]


 button.  The following dialog will then appear:
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Figure 9.  Cell Site Database Import

Choose the appropriate technology.

Click Browse to enter the import file location/name.  

Enter a database name.  Technology type will be added to the database name.  For example, if name entered is Galaxy, and technology is IS136, then the final database name is Galaxy(IS136).  This is the name of the Cell Site Database file that will be used during operation.

The “Note” column is optional.

Then click the "Import” button.  The following Import Wizard will then appear: 
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Figure 10.  Cell Site Database Import Wizard

The wizard will automatically attempt to determine the delimiter and field types.  To associate a field to a column, choose the field name from the top right combo box and then click on the header of the appropriate column.  Once all the fields are appropriately indicated click “OK” to start the import process.

When the importing is complete the database name will be available for the user to select in the Cell Site Database Configuration dialog.

Note: Cell site databases can also be imported by selecting Import Cell Site Database under File menu.

2.5.1.2. Map Setup

Click the Map page to set the map workspace.  
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Figure 11.  Application Settings 2: Map Setup

Use 
[image: image14.png]


 to browse for the workspace file.  The check box is used in Data Analysis mode to indicate that WirelessPro should not use the workspace indicated in the collected log file but to use the workspace specified Current Map Workspace. 

2.5.1.3. Other Settings

Use this page to set the default directories for Exported Data, Logging, and Test Points.
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Figure 12.  Application Settings 3: Other Settings

The check box is used to indicate whether or not the Autocall should start and stop automatically when logging is started and stopped.

2.5.2. Colors And Symbols

Colors And Symbols under the Options menu allows the user to set up thematic ranges for parameters displayed on the map and to specify the call event symbols.

2.5.2.1. Colors

To set color ranges, click the desired technology, then select the desired parameter from the drop down box.  Use the From and To columns to specify the specific ranges.  Then click the buttons under the Color column to specify the corresponding color.  Click Apply to update the changes.

2.5.2.2. Symbols

To update the call event symbols, click the Event Symbol button, then click the symbol to be changed. 

2.5.3. Alarms

The alarm feature can be used to notify the user of various events and states.  

The following events can be configured to trigger alarms:

· Call Drop

· Call Setup

· Call Setup Failure

· Call Setup Timeout

· Call Termination

· Communication Lost

· Handoff

· Handoff Failure

· Reselection

The Alarm Setup window is given below:

[image: image16.jpg]armsetn [=i

QCP2700.1 | aCP2700_2 | Gener Seting | Defaut Setup Page |

ENABLE DEVICE VARIBLES OPERATOR  CONDITION TEXT AUDID  WAVALE LEVEL  EVENT
[l e || ey | s N [l s el [T =

AddEvent Select Default Setup.

oK Cancel Apply Help





Figure 13.  Alarm Setup 1

There are 3 types of tabs to be configured.

2.5.3.1. Device tab

Each device can be configured for alarms under its corresponding tab.  The options are as follows:

1.
Variable:
Select the event to be alarmed.

2.
Text:

Check this box if you wish to be notified with a message box.

3.
Audio:

Select the type of audible alarm indication – “Beep”, “Wave” file or  “None”

4.
Wave File:
Used to select the .WAV file if “Wave” is chosen in Audio.

5.
Level:

Is the priority level for the alarm.  If two alarms are triggered at the same time, the one with highest “level” will take effect first.
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Figure 14.  Alarm Setup 2

2.5.3.2. General Settings tab

The General Settings tab is used configure alarms for general events that are not specific to any one device.  The following alarms events can be configured:

1.
GPS:

Alarm to indicate if GPS acquisition has been lost.

2.
Logger:
Alarm to indicate if logging error occurs.

2.5.3.3. Default Setup Page tab

This tab is a convenience feature.  The Default Setup Page tab is used to specify the settings that are generally to be used for new devices.  You can also use this page to apply the default settings to all devices at one time.  

3. Data Collection

3.1. Overview

WirelessPro provides real time analysis during data collection for system optimization.  The key to good data collection is ensuring data integrity.  With this in mind the WirelessPro has a simple to use interface and provides many alarming functions.
3.2. Connecting

The Connect menu button under the Config menu initializes the connection to all the devices as configured.  Make sure that all devices are on before connecting.  
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Figure 15.  Main Menu Bar

3.2.1. Main Light Indicators

In helping to ensure data integrity during testing there are five system condition indicators on the right side of the main menu bar.  From left to right, they are: 

1.
Autocall – indicates if the Autocall is running 

2.
logging – indicates if the data is being logged to file

3.
phones status – indicates if all the phones are operating normally

4.
scanners status – indicates if all the scanners are operating normally

5.
GPS – indicates if the GPS is locked.  

A green light indicates a positive verification; a red light indicates a negative verification.  A gray light indicates that the device/feature associated to it has not been initiated or that it is not in use.  

3.2.2. Phone Data Viewer Window

The phone data viewer window allows the user to monitor the phone’s state while testing or replaying.  There are generally 4 different views under phone data viewer.  The Info page displays serving channel and neighbor information, such as RSSI.  The Layer III page lists the layer 3 messages that have been received and transmitted.  The Events page contains a list of the call events.  The CSD Info page displays cell site database information.  Since the data viewer pages for each technology varies slightly, refer to section 4 for more details.  To add a data viewer window, click Phone Data under the View menu, then from pop-up menu, select the name of the desired phone.

3.2.3. Scanner Data Viewer Window

The scanner data viewer window is similar to the phone data viewer window.  It provides scanner information in a chart window.  Since the viewer varies for each technology, refer to section 4 for more details.  To add a scanner data viewer window, click Scan Data under the View menu, then from pop-up menu, select the name of the desired scanner to be displayed.

3.2.4. Summary Window

The Summary window provides a quick view of all devices.  There are four pages in the Summary window: Phones, Call Stats, Scanners, and GPS Tracking Info.  

2.7.4.1 Phones Summary Window

The Phones page lists the status of each phone under test.  The light indicator on the left shows the state of each phone.  A green light indicates that the phone is operating normally.  A yellow indicates that an abnormal call event (drop call and setup failure) has occurred.  A red light indicates that there is a problem communicating with the phone.  Also displayed on this page are the RSSI, call state, and call state time of each phone

2.7.4.2 Call Stats Summary Window
The Call Stats page lists the call statistics for all phones.  User can click RESET button to reset the statistics during the test.  

2.7.4.3 Scanner Summary Window
The Scanners page lists the status of each scanner under test.  The light indicator on the left shows the state of each scanner.  A green light indicates that the scanner is operating normally.  A red light indicates that there is a problem communicating with the scanner.  Also displayed on this page are the scan state, best Ch/PN, and best RSSI/EcIo for each scanner.

2.7.4.4 GPS Summary Window
The GPS Tracking Info page provides current GPS data including time, latitude, longitude, and speed.

3.2.5. Map Window

The map is used to display geo-coded data.  The map can display any standard MapInfo workspace.  Such a workspace usually includes streets, county or city boundaries etc.  A sample workspace is included in the example files directory.  The only requirement is that the workspace must only contain a single map window and no layout or message windows.
3.2.5.1. Preparing a MapInfo workspace for WirelessPro

You can use MapInfo to build a workspace to be used in WirelessPro.  This workspace should only contain one map and no other additional windows.  Also, make sure that all the file for the tables that are used in the workspace are located on the test computer and not on a server.  Otherwise the workspace will not load when the computer is disconnected from the server.

3.2.5.2. Setup using Main Control Bar

To setup the map, select “View” then click “Map”.
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Figure 16.  Open Map Window
WirelessPro will first attempt to load the previous workspace.  If it cannot find the previous workspace (or if this is the first time you have run the application) then a default workspace will be opened.  

3.2.5.3. Changing the Setup after the Map is displayed

Once the map is displayed you can make the following changes to the map window:
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Figure 177.  Map Display Workspace Interaction

3.2.5.3.1. Close Workspace

To start with a fresh workspace or to create your own, choose “Close Workspace” under “File.”  This will load a blank workspace into which you can open tables.

3.2.5.3.2. Open Workspace

To open another workspace, choose “File” then “Open Workspace”.

3.2.5.3.3. Save Workspace

To save the current map workspace, choose “File” then “Save Workspace”.  

3.2.6. Data Tape Window

Data Tape displays parameters’ history.  To open data tape window, select Data Tape from the View menu.  

2.7.6.1 Configuring Data Tape

Click the Config button on the data tape window to add and/or remove parameters that you wish to be displayed.  To add a parameter, double click from the Available Data Variables.  To remove a parameter, double click from the Selected Data Variables.  For every selected variable, a color is assigned.  Due to the size of the window, a maximum of 6 variables are recommended.  Click Apply to apply the changes.  

2.7.6.2 Using Data Tape

The parameters are plotted from the right to the left of the window. The most current value for a variable is at the most right of the window.   The scale of the window on the left is set for the variable name that is indicated in the yellow box.  To change the scale to another variable, double click the variable name.  To view the value of a particular variable double click at a point on the graph and a vertical line will be displayed indicating the value at that point.  The value is for the variable at the location clicked.

3.3. Start Test

3.3.1. Logging

To begin logging choose Start Log from the File menu.  A save file dialog will then appear.  Although a default log file name based on the date and time will be specified, you may enter any filename.  After clicking OK you will be prompted to include any notes for the log file.  Press OK to begin logging. 

3.3.2. Call Generation

The user can start the Autocall by either selecting Start AutoCall from the File menu or through the Autocall Window. (See section 2.4.5 for details)  

3.3.3. Auto Test Feature

The Auto Test feature simplifies the data collection by automatically starting the Autocall when logging is started and stopping the Autocall when logging is stopped.  This feature is active when the “Autocall start when logging is on” check box is checked.  (See section 2.5.1.1 for details)  Auto Test can be activated by clicking the “REC” button (the white circle) from the main menu bar or by starting a new log file.

3.4. End Test

To end a test, user can click the “STOP” button (the white square) from the main menu bar or select Stop Log from the File menu.

4. Technologies

4.1. Overview

Currently WirelessPro supports four handset technologies – CDMA, GSM, IS136, and iDEN.  The features and associated data vary by technology and are detailed below.

4.2. CDMA

4.2.1. Overview

4.2.2. Phone

4.2.2.1. Phone Configuration

No special phone configuration exists at this time.

4.2.2.2. Data Viewer

The first two pages of CDMA data viewer window displays serving channel and pilot’s information.  

The Params page shows important system parameters such window size and T_ADD.  

The Pilots page shows all pilots and the associated Ec/Io.  The Mode button allows user to switch between graphical display and table display.  Under graphical display (with black background), a blue strip indicates an active pilot, green indicates a candidate pilot, and red indicates a neighbor pilot.

The next page displays all the layer 3 messages.  To view the decoded Layer 3 message double-click the message of interest. 

The Event page lists all the call events and the time that these events occurred.  The serving pilot, its Ec/Io, and FER are also listed.

The last page is the cell site database info page.  “S”, “C”, and “N” in the first column indicate serving (active), candidate, and neighbor respectfully.  Cell site name, sector number, serving channel, PN, Ec/Io, and distance away are also listed.
4.2.2.3. Cell Site Database Format Example

Below is the format required for importing a CDMA cell site database.  You can use blank fields to indicate that the value has not changed from the previous row.  Save the information in a comma delimited file to be imported into WirelessPro.  Example cell site databases are located in the Example Files directory.

	Site
	Latitude
	Longitude
	Sector
	Center Channel
	PN
	Orientation
	Beam Width

	CDMA1
	34.0861
	-84.5922
	1
	199
	252
	30
	60

	
	
	
	
	283
	
	
	

	
	
	
	2
	199
	256
	150
	60

	
	
	
	
	283
	
	
	

	
	
	
	3
	199
	260
	270
	60

	
	
	
	
	283
	
	
	

	CDMA2
	34.0561
	-84.5523
	1
	199
	372
	30
	60

	
	
	
	2
	199
	376
	150
	60

	
	
	
	3
	199
	380
	270
	60


Table 2.  CDMA Cell Site Database Format

4.2.3. Scanner

4.2.3.1. Scanner Configuration

To configure a CDMA scanner, click Config from the main menu, then select Scanners from the drop down menu.  Click the page for the CDMA scanner in Scanner Configuration window.  Select Pilot from Scan Type drop down box.  Use the drop down boxes to change Correlation Taps, Window Size, PN Threshold, and Center Channel.  Check the check box from Measurement Parameters.  To update Scan List, user can use one of the following methods:

· Double click any single channel from Available list to add it, or double click any single channel from Scan List to remove it.

· Use “Shift” and/or “Ctrl” key to select multiple channels from either Available list or Scan List, then click “< == >” button to add or remove them.

· Click Add All or Remove All.

· Click Auto Select On.  Select from Common Group or enter Start, Stop, and Inc, then click Add.
Once the scan list is updated, click OK to close window.

SAVE and LOAD buttons allow user to save and load scanner configuration.

4.2.3.2. Collected Parameters

Up to 5 parameters are collected for CDMA scanners: Average Ec/Io, Peak Ec/Io, Aggregate Ec/Io, Delay spread, and Pilot Delay.

4.3. GSM

4.3.1. Overview

4.3.2. Phone

4.3.2.1. Phone Configuration

A lock to cell feature is available for GSM.

4.3.2.2. Data Viewer

The Info page of GSM data viewer window displays serving channel information such as serving channel, serving channel RSSI, and serving channel BCCH.  

The Neighbors page shows all channels (serving and neighbors) and their RSSI.  The Mode button allows user to switch between graphical display and table display.  Under graphical display (with black background), Red strip represents the serving channel, and blue strips represent the neighbors.  When a neighbor’s RSSI is greater than the serving channel RSSI, that neighbor is colored to green. 

The next page displays all the layer 3 messages.  To view the decoded Layer 3 message double-click the message of interest.

The Event page lists all the call events and the time that these events occurred.  The serving channel, RSSI, and RXQualSub are also listed.

The BA/CA page displays the BA list and CA list.

The last page is the cell site database info page.  The “S” and “N” in the first column indicate serving and neighbor respectfully.  The cell site name, sector number, serving channel, color code, RSSI, and distance to current location are also listed.
4.3.2.3. Cell Site Database Format Example

Below is the format required for importing a GSM cell site database.  You can use blank fields to indicate that the value has not changed from the previous row.  Save the information in a comma delimited file to be imported into WirelessPro.  Example cell site databases are located in the Example Files directory.

	Site
	Latitude
	Longitude
	Sector
	BCCH
	BSIC
	Orientation
	Beam Width
	Cell ID

	GSM1
	34.1257
	-84.2282
	1
	617
	20
	30
	60
	291

	
	
	
	2
	637
	26
	150
	60
	292

	
	
	
	3
	614
	63
	270
	60
	293

	GSM2
	34.0928
	-84.2032
	1
	630
	60
	30
	60
	301

	
	
	
	2
	640
	27
	150
	60
	302

	
	
	
	3
	618
	64
	270
	60
	303


Table 3.  GSM Cell Site Database Format

4.3.3. Scanner

4.3.3.1. Scanner Configuration

To configure a GSM scanner, click Config from the main menu, then select Scanners from the drop down menu.  Click the page for the GSM scanner in Scanner Configuration window.  Check the check box from Measurement Parameters.  Note that if Detect BSIC is checked, two drop down box, BSIC Rate and BSIC Threshold, show up on top right corner.  Check Bin Data if it is needed.  To update Scan List, user can use one of the following methods:

· Double click any single channel from Available list to add it, or double click any single channel from Scan List to remove it.

· Use “Shift” and/or “Ctrl” key to select multiple channels from either Available list or Scan List, then click “< == >” button to add or remove them.

· Click Add All or Remove All.

· Click Auto Select On.  Select from Common Group or enter Start, Stop, and Inc, then click Add.
Once the scan list is updated, adjust Samples so that the Estimated Scan Time is around 1 second.  Click OK to close window.

SAVE and LOAD buttons allow user to save and load scanner configuration.

4.3.3.2. Collected Parameters

Up to 8 parameters are collected for GSM scanners: Average RSSI, Maximum RSSI, Minimum RSSI, Standard Deviation RSSI, 10th, 50th, 90th percentile and BSIC detection.

4.4. IDEN

4.4.1. Overview

4.4.2. Phone

4.4.2.1. Phone Configuration

Single scan, multi scan, and single cell features are available for iDEN.

4.4.2.2. Data Viewer

The General Info page of the iDEN data viewer window displays serving channel information such as serving channel, serving channel rxlev, and serving channel CCCH.  It also plots Neighbor Delta, which shows the difference between serving channel rxlev, SQE and best neighbor’s rxlev, SQE.

The Neighbors page shows all channels (serving and neighbors) and their parameters (rxlev, SQE, color code, etc.).  The thin blue strip shows SQE while the wide strip shows rxlev.  Green strip represents the serving channel, light blue strips represent the foreground neighbors, and red strips represent the neighbors.  

The next page displays all the layer 3 messages.  To view the decoded Layer 3 message double-click the message of interest. 

The Event page lists all the call events and the time that these events occurred.  The serving pilot, its Ec/Io, and FER is also listed.

The last page is the cell site database info page.  “S”, “C”, and “N” in the first column indicate serving, foreground neighbor, and neighbor respectfully.  Cell site name and sector number, serving channel, color code, RSSI, and distance to current location are also listed.
4.4.2.3. Cell Site Database Format Example

Below is the format required for importing an iDEN cell site database.  You can use blank fields to indicate that the value has not changed from the previous row.  Save the information in a comma delimited file to be imported into WirelessPro.  Example cell site databases are located in the Example Files directory.

	Site
	Latitude
	Longitude
	Sector
	CCCH
	Color Code
	Orientation
	Beam Width

	IDEN1
	34.1159
	-84.2711
	1
	1085
	0
	30
	90

	
	
	
	2
	1107
	0
	150
	60

	
	
	
	3
	1129
	0
	270
	60

	IDEN2
	34.1253
	-84.2249
	1
	933
	0
	30
	60

	
	
	
	2
	1087
	0
	150
	60

	
	
	
	3
	1109
	0
	270
	60


Table 4.  IDEN Cell Site Database Format

4.4.3. Scanner

4.4.3.1. Scanner Configuration

To configure an IDEN scanner, click Config from the main menu, then select Scanners from the drop down menu.  Click the page for the iDEN scanner in Scanner Configuration window.  Check the check box from Measurement Parameters.  Check Bin Data if it is needed.  To update Scan List, user can use one of the following methods:

· Double click any single channel from Available list to add it, or double click any single channel from Scan List to remove it.

· Use “Shift” and/or “Ctrl” key to select multiple channels from either Available list or Scan List, then click “< == >” button to add or remove them.

· Click Add All or Remove All.

· Click Auto Select On.  Select from Common Group or enter Start, Stop, and Inc, then click Add.
Once the scan list is updated, adjust Samples so that the Estimated Scan Time is around 1 second.  Click OK to close window.

SAVE and LOAD buttons allow user to save and load scanner configuration.

4.4.3.2. Collected Parameters

Up to 7 parameters are collected for IDEN scanners: Average RSSI, Maximum RSSI, Minimum RSSI, Standard Deviation RSSI, 10th, 50th, and 90th percentile.

4.5. TDMA

4.5.1. Overview

4.5.2. Phone

4.5.2.1. Phone Configuration

Before an IS-136 handset can be used with the Autocall feature the handset must be programmed to speed dial a special phone book location called “TEST NUMBER”.  In TDMA phone configuration, there is a button called Set Phonebook Memory.  It is designed to help users configure their test phone to use Auto Call feature.  Each test phone only needs to be configured once.  To configure a handset for Autocall follow these steps:

· Configure the handset in the COM Ports Config dialog.

· Initialize the software by running Connect in the Config menu.

· Select Phones from the Config menu.

· Select the tab for the phone to be configured

· Press the Set Phonebook Memory button

· Then using the handset keypad and menus set “1-touch dialing” for location 8 to “TEST NUMBER”

4.5.2.2. Data Viewer

The General Info page of the TDMA data viewer window displays serving channel information such as serving channel, serving channel RSSI, and serving channel DVCC.  

The Neighbors page shows all channels (serving and neighbors) and their RSSI.  Green strip represents the serving channel, and red strips represent the neighbors.  

The next page displays all the layer 3 messages.  To view the decoded Layer 3 message double-click the message of interest. 

The Event page lists all the call events and the time that these events occurred.  The channel, RSSI, and BER are also listed.

The last page is the cell site database info page.  “S” and “N” in the first column indicate serving and neighbor respectfully.  The cell site name, sector number, serving channel, color code, RSSI, and distance to current location are also listed.
4.5.2.3. Cell Site Database Format Example

Below is the format required for importing an IS-136 cell site database.  You can use blank fields to indicate that the value has not changed from the previous row.  Save the information in a comma delimited file to be imported into WirelessPro.  Example cell site databases are located in the Example Files directory.

	Site
	Latitude
	Longitude
	Sector
	Orientation
	Beam width
	DCCH
	DVCC
	TCH
	TCHCC

	1
	34.1571
	-84.3826
	1
	0
	60
	272
	5
	272
	5

	
	
	
	2
	120
	60
	277
	5
	277
	5

	
	
	
	
	
	
	
	
	127
	

	
	
	
	3
	240
	60
	282
	5
	282
	5

	
	
	
	
	
	
	
	
	192
	

	2
	34.0579
	-84.2312
	1
	0
	60
	319
	56
	319
	56

	
	
	
	
	
	
	
	
	34
	

	
	
	
	
	
	
	
	
	109
	

	
	
	
	
	
	
	
	
	229
	

	
	
	
	2
	120
	60
	324
	56
	324
	56

	
	
	
	3
	240
	60
	329
	56
	329
	56


Table 5.  TDMA Cell Site Database Format

4.5.3. Scanner

4.5.3.1. Scanner Configuration

To configure a TDMA scanner, click Config from the main menu, then select Scanners from the drop down menu.  Click the page for the TDMA scanner in Scanner Configuration window.  Check the check box from Measurement Parameters.  Note that if Detect DVCC is checked, two drop down box, DVCC Rate and DVCC Threshold, show up on top right corner.  Check Bin Data if it is needed.  To update Scan List, user can use one of the following methods:

· Double click any single channel from Available list to add it, or double click any single channel from Scan List to remove it.

· Use “Shift” and/or “Ctrl” key to select multiple channels from either Available list or Scan List, then click “< == >” button to add or remove them.

· Click Add All or Remove All.

· Click Auto Select On.  Select from Common Group or enter Start, Stop, and Inc, then click Add.
Once the scan list is updated, adjust Samples so that the Estimated Scan Time is around 1 second.  Click OK to close window.

SAVE and LOAD buttons allow user to save and load scanner configuration.

4.5.3.2. Collected Parameters

Up to 8 parameters are collected for TDMA scanners: Average RSSI, Maximum RSSI, Minimum RSSI, Standard Deviation RSSI, 10th, 50th, 90th percentile and DVCC detection.

5. Data Analysis

5.1. Overview

Data Analysis allows the user to analyze log files by providing all the features that were available during real time data collection.  An additional feature available in Data Analysis mode is window synchronization.  Window synchronization allows the user to quickly analyze trouble areas by synchronizing all windows and views to the exact time of interest.  The user can then step forward and backward from that point in time to view all the parameters that were collected at that time.

5.2. Starting Data Analysis

5.2.1. Loading Data

To start data analysis, select Analyze Data under the File menu or click the play button (white triangle) on the main menu bar.  Once the file Open dialog box appears, browse to the directory and select the desire log file(s).  The log file configuration will appear in the right side of the dialog box.  Multiple log files can be selected by holding “Ctrl” or “Shift” key.  The configuration of the last file selected will be displayed on the right. WirelessPro allows user to export multiple files at the same time, but all the files must have the same configuration in order to be processed.  Click OK to continue.

5.2.2. Log File Filter  

The log file Filter dialog box will then pop up.  It lists all the phones and scanners that were collected in the log file.  To speed the importing process and to save memory the user has the option to select only the phones and scanners of interest to be imported.  Click OK to continue.

5.2.3. Replaying Data

Once the import process is finished, click Ok to continue.  The replay control is now in the pause mode (a yellow button shows up in the main menu bar at the location that use to be play button).  To start replaying, depress the pause button in the main menu bar.  Clicking the same button again will pause the replay.  The “+” and “-“ buttons allow user to step forward and backward.  

There are two sliders also located on the main tool bar.  The top one is for changing log file position, and the bottom one is for changing the replay speed.  To adjust these settings, simply click the slider and move it to the desired location.  

All the views traditionally available during real time are also available during Data Analysis mode.

5.2.4. Map and Data Windows Synchronization

The synchronization tool button is available during Data Analysis mode on the map window.  Using the sync tool, click on any data point of interest on the map and all the other windows in the application will synchronize to that point in time.  

6. Data Export

6.1. Overview

Data Export allows the user to export data from the log files into ASCII files, MapInfo tables, and Excel reports.

6.2. Data Export

6.2.1. Loading Data

To start data export, select Export Data under the File menu.  When the Open File dialog box appears, browse into the directory and select the desired log file(s).  The log file configuration will appear in the right side of the dialog box.  Multiple log files can be selected by holding “Ctrl” or “Shift” key.  The configuration of the last file selected will be displayed on the right. WirelessPro allows user to export multiple files at the same time, but all the files must have the same configuration in order to be processed.  Click OK to continue.

6.2.2. Log File Filter  

The log file Filter dialog box will then pop up.  It lists all the phones and scanners that were collected in the log file.  To speed the importing process and to save memory the user has the option to select only the phones and scanners of interest to be imported for exporting.  Click OK to continue.

6.2.3. Export Setup

There are two output formats supported by WirelessPro data export.  One is Table, and the other is Report.  A Table is a file that lists the data of all selected parameters.  It could be either in ASCII/text format and/or MID/MIF format.  Both of these formats are easily imported into MapInfo.  A Report is a excel spreadsheet that consists of a summary sheet and other sheets such as call statistics, variable statistics, and/or variable PDF/CDF plots.

6.2.3.1. Create a Table

To create a Table, click New Table.  Table Options will appear, and the Table 1 is created and added to the tree on the right.  GPS time, latitude, and longitude are added to the new table by default.  From Table Options, choose the format by check ASCII Format, MIF Format, or both.  Then from tree on the left, find the desired variable and add it to the tree on the right by either double-click the variable or select the variable then click => button.  Once all the variables are added.  It is the time to set Index Field.  The Index Field is the variable that is used to synchronize the export.  All other variables will be updated (add a new line in the output file) when Index Field variable is updated (a new message received).  For example, a 20 minutes CDMA log file will have about 1200 GPS time messages and many times more finger 1 Ec/Io messages.  If the GPS time is used as the Index Field, the output file will have 1200 lines, one for each GPS time message.  If finger 1 Ec/Io is used, there would be a line for each new finer 1 Ec/Io message – many more than for the GPS time message updates. 

6.2.3.2. Create a Report

To create a Report, click New Report.  Report Options will appear, and the Report 1 is created and added to the tree on the right.  GPS time is added to the new report by default.  There are three choices when adding a variable to the report: Call Events, Statistics, and PDF.   Thus, before adding a variable, one of these three must be selected first.  To add a variable, either double-click it or select it and click => button.  
6.2.3.3. Save, Load, And Delete

The Table and Report can also be saved, loaded, and deleted.  Once a Table is created, select the Table, click Save Table button, then use the Save As dialog box to save the Table.  To load a table, click the Load Table button, then follow the Open dialog box to load the Table.   To delete a Table, just select the Table, then click Delete Table.  Note that Delete Table is not available until at least one Table is created.  Reports are saved, loaded and deleted in similar fashion.

6.2.4. Export

Once all the Tables and Reports are created, enter the output name to the space at the top.  The output files for all the Tables will be named like “NameEntered_table#” while “#’ is the table number.  All the output files will be created and saved under directory WirelessPro/User Files/Exported Data/.  After the exporting process is done, if a Report was exported, then an Excel book will appear.  If the user desires to keep the information found in the Excel report the user will need to save the spreadsheet within Excel.

7. In-Building Test

7.1. Overview

The in-building module allows the user to collect phone and scanner data without using GPS.  Often performed as a walk test this feature allows the user to specify the locations he/she will be traveling on the map display.  The location information is saved and displayed on the map.

7.2. Build Workspace

In order to build the in-building workspace, an image file is needed.  This file can be any image format such as bitmap and jpeg.  Before connecting, select Map under the View menu.  When the Map window opens close the current workspace by selecting Close Workspace under the File menu.  Then select Load Image to import the image file.  The user will be asked to save the workspace once the image is loaded.

7.3. Start Test 

Before connecting, WirelessPro needs to be set to in-building test mode.  To do this, select Map under View menu.  Then check In-Building Mode under In-Building menu from Map window.

7.3.1. Create Test Points

Once the in-building mode is set, the user needs to create test points on the map.  Select New Test Points under the In-Building menu to create new test points.

Click the 
[image: image21.png]


 button from Map window tool bar.  Now click on the map to create test points.  

7.3.2. Save And Load Test Points

Test points can be saved and loaded.  Select Save Test Points under In-Building menu from Map window to save test points.  Select Load Test Points under In-Building menu from Map window to load it.

7.3.3. Start Test

After test points are created, user should start logging and Autocall if needed.  Then, click 
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 button from Map window tool bar and begin walking toward your next location as indicated on the map.  When you reach the next target location, click the 
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 button on the Map Dialog tool bar.  Repeat this process until the last test point is reached.  During the walk test the user can click 
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 to pause.

7.4. End Test

To end a walk test click the 
[image: image25.png]


 button from Map window tool bar.  If a new test is desired, select New Test Points under In-Building menu from Map window. 
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WirelessPro 


Technical Specifications




CDMA Phone 


Serving Cell Information


SID


NID


BASE ID


Serving Channel Parameters


Channel Number


Channel RSSI


Mobile TX Power


Walsh Code


FER (Instantaneous)


FER (Cumulative)


Dominant Pilot


Dominant Pilot Ec/Io


Coder Rate


Finger Information


Pilot


Offset


Ec/Io


Aggregate Ec/Io


Pilot Set Information

PN 


Ec/Io


Typical Logging Rate


5.0 MB/Hour

GSM Phone


Serving Cell Information

Cell ID


LAC


MCC


MNC


BA List


CA List


Serving Channel Parameters

RxLevFull


RxLevSub


RxLevIdle


TX Power


Timing Adv


DTX


RLT


BCCH


MAIO


BSIC


Time Slot


TCH


RxQualFull


RxQualSub


Neighbor Information

BCCH


BSIC


RxLev


Typical Logging Rate

2.8 MB/Hour



IS136 Phone 


Serving Channel Parameters

SID


RSSI


DCCH


DTC


DCC/DVCC 


Time Slot


BER 


RxQual


TX Power


MRLQ


Timing Advance


Channel Type


Phone State


Analog RSSI


Neighbor Information

Channel


RSSI


Typical Logging Rate

1.0 MB/Hour

iDEN Phone


Serving Channel Parameters

RSSI


Channel


Color Code


IL


Channel Type


Offset


SQE


Neighbor Information

Channel


Color Code


RSSI


SQE


Typical Logging Rate

0.7 MB/Hour

CDMA Scanner 


PN Measurements Options

Aggregate Ec/Io


Peak Ec/Io


Average Ec/Io


Delay Spread


Pilot Delay


CW Measurements Options

Average RSSI

Receiver Specifications


Receiver Bandwidth: 50 kHz


Base Sensitivity: -95 to –25 dBm


Ext. Sensitivity:-105 to –20 dBm


Base Accuracy: +/- 1 dB


CW Scan Rate1: 80 Ch / sec


CW Scan Rate2: 70 Ch / sec


PN Scan Rate: 512 PN / 1.5 sec

Typical Logging Rate

1.7 MB/Hour



GSM Scanner


RSSI Measurements Options


Average


Min


Max


Standard Deviation


10, 50, 90th percentile


Wave Distance Averaging


BSIC Decoding


Receiver Specifications

Receiver Bandwidth: 200 kHz


Base Sensitivity:-102 to –25dBm


Ext. Sensitivity: -115 to –20dBm


Base Accuracy: +/- 1 dB


CW Scan Rate1: 325 Ch / sec


CW Scan Rate2: 195 Ch / sec


BSIC Decode Rate: 15 Ch / sec


Typical Logging Rate

0.8 MB/Hour

IS-136 Scanner


RSSI Measurement Options  


Average


Min


Max


Standard Deviation


10, 50, 90th percentile


Wave Distance Averaging


DCC Decoding


Receiver Specifications

Receiver Bandwidth: 30 kHz


Base Sensitivity:-110 to –25dBm


Ext. Sensitivity: -120 to –20dBm


Base Accuracy: +/- 1 dB


CW Scan Rate1: 407 Ch / sec


CW Scan Rate2: 245 Ch / sec


DCC Decode Rate: 50 Ch / sec


Typical Logging Rate

1.7 MB/Hour

iDEN Scanner 

RSSI Measurements Options  


Average


Min


Max


Standard Deviation


10, 50, 90th percentile


Wave Distance Averaging


Receiver Specifications

Receiver Bandwidth: 25 kHz


Base Sensitivity:-116 to –30dBm


Ext. Sensitivity: -120 to –20dBm


Base Accuracy: +/- 1 dB


CW Scan Rate1: 280 Ch / sec


CW Scan Rate2: 175 Ch / sec


Typical Logging Rate

0.6 MB/Hour

Notes:


CW Rate1 specified for scans with < 256 channels


CW Rate2 specified for scans with >= 256 channels
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Notes:


CW Rate1 specified for scans with < 256 channels


CW Rate2 specified for scans with >= 256 channels
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